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 Overview

The goal of color management is to define correct color for monitors, printers and other devices. This
is done by checking how your devices reproduce color, and then building a color correction profile for
each. These profiles work as translators, determining how color on that device relates to a universal
color standard. These color profiles are then placed in a special folder within your operating system.
Any time color data is sent from one device to another, from your application as displayed by your
monitor to a printer for instance, the application or operating system’s Color Management Module
(CMM) translates the color data from the profile of the source, to a universal color standard, then on
to the profile of the destination device.

Color management is needed because all digital color devices reproduce color differently, even when
each is responding to the same RGB numbers in an image. In computing, this fact is referred to as
device dependent color; the color depends on the device, and varies between devices. The
manufacturers of monitors and printers often provide generic profiles with the installation software
that accompanies the product. In addition Apple and Microsoft® include generic profiles for many
common peripherals that are installed with the operating system. Of these devices your monitor is the
most variable component for two reasons. The first is that monitors typically include user controls for
adjusting the brightness, contrast, and color balance which may be set so the monitor’s actual
performance is not accurately described by a generic profile for the monitor. A second reason is that
the phosphor screen coatings on CRT monitors and the fluorescent lights and dyes in LCD monitors
change over time.

Because digital images are color corrected and adjusted on screen, the accuracy of the monitor is
key to balancing the entire color management system. For example: when scanning an image, the
preview used to make adjustments is based on the monitor profile, if this profile is inaccurate, the
resulting scan will be incorrect. At the other end of the workflow, a color image you are editing in an
application such as Adobe® Photoshop® will not dependably match your printout unless an accurate
monitor profile is being used to display and proof the image.

The seven sensors of the Spyder accurately read the color, brightness and other characteristics of
your monitor, allowing the OptiCAL software to first adjust your monitor to an optimal state, then
precisely define that state as a color profile. The instructions that follow cover both the process of
calibrating your monitor and examples of using the resulting profile.
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Installation & Use

For Macintosh

Insert OptiCAL CD into your CD-ROM drive.
Double-click on the OptiCAL Folder.
Double-click on the OptiCAL Installer icon.
Attach the Spyder USB connector to your computer. (Note: OptiCAL will not function unless the Spyder is
properly attached.)
Before running OptiCAL, run PreCAL to white balance your monitor.
Launch OptiCAL by doubel-clicking on the OptiCAL application icon.
Set Target Parameters.
Choose Gamma 1.8 (or desired value) from Targets and Curves popup menu in the main window.
Choose Native from Color Temperature popup menu in the main window.
Click Calibrate in the main window.
A dialog box will appear. Mark the checkbox for ColorSync Profile and click Continue.
Follow the Calibration Process Instructions.
When the Calibration Process has ended, remove the Spyder from your display. Your monitor is now calibrated
and profiled.

 dispay. Your monitor is now calibrated and profiled.
For Windows®

Insert OptiCAL CD into your CD-ROM drive.
Double-click on the OptiCAL Folder.
Double-click on the OptiCAL Setup icon.
Attach the Spyder USB connector to your computer. (Note: OptiCAL will not function unless the Spyder is
properly attached.)
The New Hardware Wizard will open automatically. Follow on-screen instructions to successfully load your Spyder
Driver.
Before running OptiCAL, run PreCAL to white balance your monitor.
Launch OptiCAL by double clicking on the OptiCAL application icon.
Set Target Parameters.
Choose Gamma 1.8 (or desired value) from Targets and Curves popup menu in the main window.
Choose Native from Color Temperature popup menu in the main window.
Click Calibrate in the main window.
A dialog box will appear. Mark the checkbox for ICC Profile and click Continue.
Follow the Calibration Process Instructions.
When the Calibration Process has ended, remove the Spyder from your display. Your monitor is now calibrated
and profiled.



6

OptiCAL User Interface

Main Window

The Main Window is opened, and remains open, while the OptiCAL application is being used.
Through this window the user can access all activities (File, Edit, Tools and Help) associated with the
performance of OptiCAL.

Note:  For the Macintosh, the menu items are located at the top of the screen.
Image 1: Main OptiCAL Window

The Last Calibration field shows the date and time the display was last calibrated.  If the display has
not been calibrated, as when OptiCAL is first launched, “na” is shown in the Last Calibration field.

The Targets and Curves pulldown menu allows the user to specify parameters in which the monitor
can be calibrated to meet the user’s criteria.  Either Target files, which incorporate both tone
response curves and color temperature information, or pre-determined Gamma Curve files, which
incorporate only tone response curves, can be specified.  Monitor profiles may also be loaded as
Target files.  When they are loaded into the OptiCAL Target folder, they are displayed in the
pulldown menu along with the other preset Target files.

The Color Temperature pulldown menu allows the user to specify a predetermined color temperature
in which the monitor can be calibrated.

The Calibration button initiates the calibration process.

The OptiCAL on checkbox allows the user to toggle the OptiCAL correction on and off from the main
window.

Note:  For the Macintosh Platform, Selected Display pulldown menu is featured.  This feature allows
the user to specify which display is currently being affected.  In the single display scenario, the
pulldown menu is simply a field with the name of the display.  In a multi-display scenario, the name of
each display is listed in alphabetical order.



7

File Menu
Image 2: File Menu

Open Target…
This allows the user to load a pre-saved Target file as the currently selected target in the OptiCAL
program.  These files are displayed through a file dialog that lists all pre-set and user preferred Target
Profiles.

Save Target As…
This option allows the user to create an OptiCAL Target file using the current Tone Response Curve
and Color Temperature settings.

Calibrate…
When the Calibration process is initiated, the raw state of the display is measured, and a correction
applied to the video board to match the display’s characteristics to the specified Target.

Generate Profile…
In this process, the display is measured with the current correction active and a profile of the display
is saved.  After the Generate Profile process is completed, the Curve D, White Point, DE and
Phosphor fields are updated in all the OptiCAL windows.

Validate Calibration…
This process measures the Gamma and color temperature of the display with the current correction
applied.  After the Validation process is completed, the Curve D, White Point, DE and Phosphor fields
are updated in all the OptiCAL windows.

Print Information…
This selection provides a hard copy of information describing the display’s current condition.

Exit
Allows the user to close down the OptiCAL window.
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Note:  For Macintosh Platform (in order from top to bottom):
Open Target
Save Target As…
Calibrate…
Generate Profile…
Validate Profile…
Page Setup - initiates the standard Apple Page Setup dialog.
Print Information
Quit

Edit Menu
In the edit mode, the user can access the Preferences dialog box.

Image 3:  Edit Menu

Note:  For Macintosh Platform, the Edit activity, Preferences and Display Configuration can be
accessed.
Display Configuration shows the structure as it is set in the Monitor’s Control Panel.  The Display
Name field shows the name of the currently selected display.  This field can be edited by typing in the
preferred monitor name.



9

Preference Dialog
Preferences contains the application and sensing options (Calibration Sensor, Sensor Port,
Calibration Mode, Sensor Information, Expert Controls, Maximum Delta E, Recalibration Period) of the
OptiCAL program.  The user can establish the basis of the monitor calibration to be performed.

Image 4:  Preferences Dialog

The Calibration Sensor is a pulldown menu allowing the user to select the sensor to be used with
OptiCAL.  OptiCAL then searches for the designated device and verifies the established parameters.
If the Sensor is not recognized, a message will appear indicating that the sensor could not be found
and the Calibration pulldown menu would default to “None.”

The pulldown menu of the Sensor Port works in conjunction with the Calibration Sensor selection.  If
the selected sensor is a serial device, the Sensor Port is made active and the user can specify the
com or serial port, through which the device is connected.

The Sensor Information items display information about the connected sensor.

The Serial Number field displays the device serial number of the currently selected calibration
sensor.

The Version field displays the software version number of the currently selected calibration sensor.

The Calibration Mode is available in two modes, Standard and Precision.  Changing Calibration
Modes modifies the way the Brightness and Contrast controls of the display are adjusted during the
Calibration process.  During this process the display must be preset, both Brightness and Contrast, to
maximize the dynamic range of the display.

In Standard mode, OptiCAL uses a displayed image and instructs the user toward manually
presetting the Brightness and Contrast values of the display before calibrating.

In Precision mode the calibration sensor is used to precisely measure and set the Brightness and
Contrast of the display to specific Luminances.

The Expert Controls are active when its checkbox is selected.  While active, control points are
activated on the Target Curves in the Curves window.  These control points can be manipulated,
changing the Target Tone Response Curves; OptiCAL will be calibrating the display to match the
preferred settings.  The effect of control point shifts can be viewed dynamically as OptiCAL
regenerates the applied correction.

The Maximum DE Limit field sets the maximum acceptable DE for the color temperature.  If, after a
Calibrate, Validate Calibration, or Generate Profile process is performed, the Calibrated color
temperature is more than the specified DE from the Target color temperature, a warning message is
displayed.
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The Recalibration Period defines a period of time which the user can be reminded to perform the
next calibration of the display monitor.  Regular recalibration is required to maintain color consistency.
We recommend a display should be recalibrated approximately every two weeks to remain accurate.
When the selected interval has been exceeded, a message is displayed reminding the user to
perform a calibration.
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Tools Menu
The tools menu provides diagnostic readouts of the current calibration.  Within the tools menu, the
user can observe tone response curves, review information on current status, and perform
colorimetric spot measurements.

Image 5:  Tools Menu

Curve Window
Image 6: Curves Window

The Curves window displays the tone response curves defined and created by OptiCAL.  In the
Graph Area, these curves give the user visual feedback on the display’s characteristics before and
after calibration, the target curve and the individual RGB curves.
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The Graph Mode pulldown enables the user to specify the information to be displayed in the graph
area.  Graph Mode selections include Global (which displays all three channels at once), Red, Green
or Blue.  The user can individually view a specific RGB color graph by selecting the Red, Green or
Blue channels.

The modes can be switched via keystroke by pressing:
{Control} {~} for Global (all channels)
{Control} {1} for Red channel
{Control} {2} for Green channel
{Control} {3} for Blue channel

Note:  For the Macintosh Platform, use command key instead of the Control key.

The Show Curves checkboxes turn on and off the curves displayed in the Graph Area.

Target checkbox turns the Target curve on and off in the graph area.  The Target curve represents
the preferred tone response curves defined by the selection made from the Targets and Curves
pulldown menu.

Uncalibrated checkbox turns the Uncalibrated curve(s) on and off in the graph area.  Uncalibrated
curve(s) represent the direct readings taken from the monitor by the calibration sensor during the
calibration process.  They illustrate the characteristics of the monitor without corrections applied.

The Calibrated checkbox turns the Calibrated curve(s) on and off in the graph area.  The Calibrated
curve(s) show the accuracy of the calibration, relative to the Target, with the OptiCAL correction
applied.

Note:  The calibrated curves are active only after a Generate Profile or Validate function has been
performed on the current target settings.

The Correction checkbox turns the Correction curve(s) on and off in the graph area.  The Correction
curve(s) shows the correction OptiCAL is making to match the monitor to the selected target
parameters.

The Global Adjustment Curve, visible within the Graph Area, allows the Red, Green and Blue Target
curves to be adjusted simultaneously.  The Global Adjustment Curve is linear, and is visible only
when Expert Controls, located in the Preferences dialog, is turned on.  Adjustments are made to this
curve by manipulating the control points located along the curve.

The Control Points pulldown menu allows the user to select the number of Control Points placed on
the Target curves.  The pulldown menu is visible only when Expert Controls, located in the
Preferences dialog, is turned on.  The menu displays either 1, 3 or 9 points may be selected, for
varying degrees of precision in customizing the Target curves.

The Input and Output fields display a numerical value (0 to 255) for the position of the currently
selected control point. These fields are visible only when Expert Controls is turned on.
The Reset button enables the user to reset the Global Adjustment curve to linear. The Reset button
is visible only when Expert Controls is turned on.
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Display Information

The Display Information window shows information relating to the current status of OptiCAL.

Image 7: Information Window

The Display Luminance fields show the Brightness Levels, in cd/m2, of the monitor in its
Uncalibrated, Targeted and Calibrated states of brightness.

The White Point (CIE x,y) fields show the CIE x,y chromaticity coordinates for the Uncalibrated,
Target and Calibrated white point values.

The Uncalibrated chromaticity coordinates are taken from the last calibration process.

The Target chromaticity coordinates are the CIE x,y coordinates of the currently selected Target
Color Temperature.

The Calibrated chromaticity coordinates indicate the accuracy of the calibration, relative to the Target
White Point.

The Phosphors (CIE x,y) fields show the x,y chromaticity coordinates of the display’s Red, Green
and Blue phosphors.

The Delta E Color Temperature (Luv) fields show the measured OptiCAL difference between the
Target Color Temperature and the Calibrated Color Temperature for the White and 50% Gray points
of the monitor.

The White Point field shows the measured DE of the white point (255 RGB) Color Temperature of the
monitor.
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The 50% Gray field shows the measured DE of the mid-point (128 RGB) Color Temperature of the
monitor.
The Curve Delta (Target vs. Calibrated) field indicates the difference between the Target tone
response curves and the Calibrated curves for the individual RGB color channels.

Colorimeter Window
The Colorimeter window allows the user to take individual measurements with the calibration sensor.
Image 8:  Colorimeter Window

Take Reading button initiates the use of the sensor to perform a measurement or reading, and
updates the Color Space fields with the new values.  The RGB fields enable the user to specify Red,
Green and Blue values to display a pre-determined color in the window.

Black Cal button resets the black calibration of the sensor, enabling the user to manually initiate the
sensor calibration routine.  If the attached sensor does not require black point calibration, the Black
Cal button is inactive (grayed out).

The CIE-XYZ, CIE-Yxy and CIE-L*u*v color space fields show the readings taken with the sensor,
translated into each of their respective color spaces.

The Kelvin field shows the Color Temperature reading taken by the sensor.

The Luv value indicates how far the measurement is from the Blackbody Locus.

The fL field indicates the reading taken with the sensor, measured in foot Lamberts.
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Monitor Calibration Procedures

This section is designed to guide the user through a basic monitor calibration process.  There are
three scenarios; single-display calibration, multi-display calibration and multi-system calibration.  We
suggest that the user select one of the scenarios that most closely represents your system’s
conditions. The default values of Gamma 1.8 and color temperature of 65000K are used in all three
scenarios, although the user can set different target parameters to meet the user’s specific
requirements.

Single-Display Calibration

This process describes the calibration of a system having one monitor display.  In this scenario, the
dynamic range of the display is maximized visually, and the ambient lighting condition of the monitor’s
environment is automatically taken into account.

Launch OptiCAL.
Program will initiate and the main window will appear on screen (see Figure 4-1).  The program is
ready for user’s input specifications.
Note:  Make certain the calibration sensor is connected. For those who have the OptiCAL icon on the
desktop, double click on icon.

Choose Monitor type: CRT or LCD.
If you are calibrating a CRT monitor, the Spyder uses suction cups to adhere to the glass of the CRT
monitor. If you are calibrating a LCD monitor, please attach the LCD attachment to the Spyder as
outlined in the diagram below.

The LCD Spyder attachment ensures that the suction cups will not touch the LCD display. It also
provides an easy way to adjust to the dimensions of most any LCD from large 22” desktops to
notebook computers.

IMPORTANT NOTE
DO NOT ATTACH THE SUCTION CUPS OF THE SPYDER TO A LCD MONITOR. THIS COULD

POTENTIALLY CAUSE DAMAGE TO YOUR DISPLAY.
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Set OptiCAL Preferences.
Click {Edit} on the OptiCAL Toolbar.
Click {Preferences}; Preference dialog box will appear. (see Figure 4-4)
Check to see that the Calibration Sensor has matched your sensor type.
Set the Calibration Mode to {Standard}.
Click {OK} to exit the Preferences dialog.

Set target parameters.
Select Gamma 1.8 or other appropriate setting from the Targets and Curves droplist provided on the
Main Window.
Select  6500 or other appropriate setting from the Color Temperature droplist provided on the main
window.

Make certain OptiCAL is turned on.
If it is not on, click the {OptiCAL on} checkbox in the main window.



17

Initiate the Calibration process.
Click the {Calibrate} button in the main window.  A dialog box appears prompting the user to select an
ICC Profile or Adobe Monitor Setup Profile.
Click on the ICC Profile checkbox and continue.

Image 9:  Profile Dialog Box

Preset the display’s Brightness and Contrast.
Increase the display’s Contrast controls to Maximum.
Decrease the display’s Brightness controls to Minimum.
For LCDs, you simply reset these controls to defaults, unless you need to match a specific brightness
on the other monitors.
Click {Continue}.

Fine tune the Brightness controls.
Increase the display’s Brightness until the OptiCAL target image can “JUST be seen” within the black
Calibration dialog window. This option may not occur with some configurations.
Image 10: OptiCAL Image “Just be seen” View

Note: “JUST be seen” refers to the point at which reducing the Brightness any more makes the target
image indistinguishable in the black box.

Attach the calibration sensor to the display. (Follow CRT or LCD instructions.)

Continue the Calibration process.
Once the measurement process is complete, the correction will be applied to the display and the
application will revert to the main window.
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The Display is now calibrated.
Modifying the Target Parameters.
After the initial calibration, the target parameters for the calibration can be changed without
recalibrating.  Toggle through the selections in the Targets and Curves droplist to get an idea of the
effect each selection has on the correction.  Also, toggle through the selections in the Color
Temperature droplist to get an idea of the effect of color temperature changes.  When you have
settled on a set of parameters, you can quit the application and the calibration will remain active until
the next time you calibrate with OptiCAL.

Maintaining Single-Display Calibration.
OptiCAL can be set to predetermined intervals that will prompt you to recalibrate.  Select an interval
in the Recalibration Period droplist of the Preferences dialog.  This feature will announce when that
recalibration is necessary.  At this point, you can launch the OptiCAL application and follow the steps
that you used to calibrate the display initially.

Note:  It is not necessary to adjust the Brightness controls from the previous calibration; omit the
preset Brightness and Contrast instructions in the Calibration process.
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Multi-Display Calibration

This process details the calibration of a system having two or more monitors attached to a single
CPU.
In this process, the dynamic range of the first display is maximized visually, where the ambient lighting
condition of the monitor’s environment is automatically taken into account. The additional displays are
then calibrated to match the dynamic range, color temperature and tone response of the first display.

Note: This procedure is a feature available only on Macintosh platforms.

Launch OptiCAL.:
Program will initiate and the main window will appear on screen (see Figure 4-1).  The program is
ready for user’s input specifications.

Note:  Make certain the calibration sensor is connected. For those who have the OptiCAL icon on the
desktop window, double-click on icon.

Choose Monitor type: CRT or LCD.

Set OptiCAL Preferences.
Click {Edit} on the OptiCAL Toolbar.
Click {Preferences}; Preference dialog box will appear. (see Figure 4-4)
Check to see that the Calibration Sensor has matched your sensor type.
Set the Calibration Mode to {Standard}.
Click {OK} to exit the Preferences dialog.

Check display configuration.
Open the Display Configuration dialog from the Edit menu.
Click on the individual display icons to show their display names.
To rename the displays, type the new name in the appropriate Display Name field.

Set target parameters. (see Figure 4-1)
Select Gamma 1.8 or other appropriate setting from the Targets and Curves droplist provided on the
Main Window.
Select 6500 or other appropriate setting from the Color Temperature droplist provided on the main
window.

Make certain OptiCAL is turned on.
If it is not on, click the {OptiCAL on} checkbox in the main window.

Select the target monitor to which the other monitors will be calibrated.
All calibrated displays will achieve the same color temperature and tone response characteristics.
What will be different is their dynamic range.  To match multiple displays as closely as possible their
dynamic ranges must be equalized.  Select the display with the least amount of natural brightness for
white.  This is the display to which others will be matched.  It is used as the target display because,
while the brightness of a dim display cannot be increased, the brightness of a bright monitor can be
decreased.

Initiate the Calibration process.
Click the {Calibrate} button in the main window.  A dialog box appears prompting the user to select an
ICC Profile or Adobe Monitor Setup file to generate.
Click on the appropriate checkbox and continue. (see Figure 5-1)

Calibrate the calibration sensor. (if applicable).
Follow the instructions given in the Calibration dialog for calibrating the device.
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Click {Continue}.

Preset the display’s Brightness and Contrast.
Increase the display’s Contrast controls to Maximum.
Decrease the display’s Brightness controls to Minimum.
For LCDs, you simply reset these controls to defaults, unless you need to match a specific brightness
on the other monitors.
Click {Continue}.

Fine tune the Brightness controls.
Increase the display’s Brightness until the OptiCAL target image can “JUST be seen” within the black
Calibration dialog window.

Note: “JUST be seen” refers to the point at which reducing the Brightness any more makes the target
image indistinguishable in the black box.

Attach the calibration sensor to the display. (Follow instructions for LCD or CRT.)

Continue the Calibration.
Once the measurement process is complete, the correction will be applied to the display and the
application will return to the main window.
The Target Display is now calibrated.

Saving the first calibration target parameters.
Select Save Target As... from the File menu.
Click on the Define Luminance Yes checkbox.  This opens a dialog box containing White and Black
luminance fields as well as the Measure Luminances button.
Click on the Measure Luminances button.
Attach the sensor to the screen to measure the White and Black luminances.
Click {Continue} to exit the Define Luminances dialog.
Name and Save the Target file located in the OptiCAL Targets folder, in the OptiCAL application
folder.

Select the next display to be calibrated.

Reset the OptiCAL Preferences.
Open the Preferences dialog box from the Edit menu.
Set the Calibration Mode to {Precision}. (see Figure 4-4)
Click {OK} to exit the Preferences dialog.

Select the saved target parameters of the first calibration.
Select Other Target... from within the Targets droplist.
Select the Target file saved in step #13.

Make certain OptiCAL is turned on.
If it is not on, click the {OptiCAL on} checkbox in the main window.

Initiate the Calibration process.
Click the {Calibrate} button in the main window.  A dialog box appears prompting the user to select an
ICC Profile or Adobe Monitor Setup file to generate.
Click on the appropriate checkbox and continue. (see Figure 5-1)

Preset the display’s Brightness and Contrast.
Increase the display’s Contrast controls to Maximum.
Decrease the display’s Brightness controls to Minimum.
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Click {Continue}.

Attach the calibration sensor to the display.

Match the black point luminance of the first and second displays.
Increase the Brightness controls of the display until the Current Luminance value matches the Target
Luminance value.

Note:  Even with the Brightness controls minimized, the Current Luminance of black is greater than
the Target Luminance, the second display will not be able to achieve the black point luminance of
the target display.  In this case, you may wish to make the second display the target display.

Match the white point luminance of the first and second displays.
Decrease the Contrast controls of the display until the Current Luminance value matches the Target
Luminance value.

Note:  Even with the Brightness controls maximized, the Current Luminance is less than the Target
Luminance, the second display will not be able to achieve the white point luminance of the target
display.  In this case, you may wish to make the second display the target display.

Continue the Calibration process.
Once the measurement process is complete, the correction will be applied to the display and the
application will return to the main window.
The Second Display is now calibrated to match the Target Display.

Note:  If you have more than two displays on your system, repeat steps 14 through 23 with each
additional display.

Modifying the Target Parameters.
The target parameters for the calibration can be changed, after the initial calibration, without
recalibrating.  Toggle through the selections in the Targets and Curves droplist to get an idea of the
effect each selection has on tone response.  Also, toggle through the selections in the Color
Temperature droplist to get an idea of the effect of color temperature changes.  When you have
settled on a set of parameters, you can quit the application and the calibration will remain active until
the next time you calibrate with OptiCAL.

Note: Unlike changes to the target tone response, changing the target color temperature will affect
the white point brightness. The amount of brightness change will also vary from display to display.
Keeping the dynamic ranges of multiple displays accurately calibrated to each other when changing
the target color temperature will require resaving the target parameters and recalibrating the
secondary displays.

Maintaining Multi-Display Calibration.
OptiCAL can be set to predetermined intervals that will prompt you to recalibrate.  Select an interval
in the Recalibration Period droplist of the Preferences dialog.  This feature will announce when that
recalibration is necessary.  At this point, you can launch the OptiCAL application and follow the steps
that you used to calibrate the secondary display.  Check to ensure the Calibration mode is set to
Precision.  Select the saved target file and follow the same procedure as before.  The target display
can also be recalibrated this way, using Precision mode and the same target file that was used for
the secondary displays.
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Multi-System Calibration

This process describes how to calibrate two or more systems, each having one display attached.  In
this scenario, the dynamic range of the display on the first system is maximized according to the
ambient lighting condition of the environment.  The displays of the subsequent systems are then
calibrated to match the dynamic range, color temperature and tone response of the first system
display.

Select the system with the target display.
Establishing a target system for the other system displays will be calibrated to match, the initially
selected system. All the displays, once calibrated, will achieve the same color temperature and tone
response characteristics.  What will make them different is their dynamic ranges.  To match multiple
displays as closely as possible, the dynamic ranges of the displays must be equalized.  Select the
display that has the least amount of natural brightness for white.  This becomes the display to which
the others will be matched.  The display with the least brightness is used as the target display
because, though we cannot increase the brightness of a dim display, we can decrease the
brightness of a bright.

Launch OptiCAL.
Program will initiate and the main window will appear on screen (see Figure 4-1).  The program is
ready for user’s input specifications.

Note:  Make certain the calibration sensor is connected. For those who have the OptiCAL icon on the
desktop window; double-click on icon.

Choose Monitor type: CRT or LCD.

Set OptiCAL Preferences.
Click {Edit} on the OptiCAL Toolbar
Click {Preferences}; Preference dialog box will appear. (see Figure 4-4)
Check to see that the Calibration Sensor has matched your sensor type.
Set the Calibration Mode to {Standard}.
Click {OK} to exit the Preferences dialog.

Set target parameters. (see Figure 4-1)
Select Gamma 1.8 or other appropriate setting from the Targets and Curves droplist provided on the
Main Window.
Select 6500 or other appropriate setting from the Color Temperature droplist provided on the main
window.

Make certain OptiCAL is turned on.
If it is not on, click the {OptiCAL on} checkbox in the main window.

Initiate the Calibration process.
Click the {Calibrate} button in the main window.  A dialog box appears prompting the user to select an
ICC Profile or Adobe Monitor Setup file to generate.
Click on the appropriate checkbox and continue. (see Fig. 5-1)

Calibrate the calibration sensor (if applicable).
Follow the instructions given in the Calibration dialog for calibrating the device.
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Click {Continue}.

Preset the display’s Brightness and Contrast.
Increase the display’s Contrast controls to Maximum.
Decrease the display’s Brightness controls to Minimum.
For LCDs, you simply reset these controls to defaults, unless you need to match a specific brightness
for proofing. Click {Continue}.

Fine tune the Brightness controls.
Increase the display’s Brightness until the OptiCAL target image can “JUST be seen” within the black
Calibration dialog window.

Note  “JUST be seen” refers to the point at which reducing the Brightness any more makes the target
image indistinguishable in the black box.

Attach the calibration sensor to the display.

Continue the Calibration.
Once the measurement process is complete, the correction will be applied to the display and the
application will revert to the main window.
The Display is now calibrated.

Saving the target parameters of the first system’s calibration.
Select Save Target As... from the File menu.
Click on the Define Luminance Yes checkbox.  This opens a dialog containing White and Black
luminance fields as well as the Measure Luminances button.
Click on the Measure Luminances button.
Attach the sensor to the screen to measure the White and Black luminances.
Click {Continue} to exit the Define Luminances dialog.
Name and Save the Target file located in the OptiCAL Targets folder of the OptiCAL application
folder.

Launch OptiCAL on the next system.
Program will initiate and the main window will appear on screen (see Figure 4-1).  The program is
ready for user’s input specifications.

Note: For those who have the OptiCAL icon on the desktop window, double-click on icon.
Make certain the calibration sensor is connected.  Refer to the calibration sensor user’s guide for
installation and connection.

Set OptiCAL Preferences.
Click {Edit} on the OptiCAL Toolbar.
Click {Preferences}; Preference dialog box will appear. (see Figure 4-4)
Check to see that the Calibration Sensor has matched your sensor type.
Set the Calibration Mode to {Precision}.
Click {OK} to exit the Preferences dialog.

Select the saved target parameters of the first calibration.
Select Other Target... from within the Targets droplist.
Select the Target file saved in step #12.

Make certain OptiCAL is turned on.
If it is not on, click the {OptiCAL on} checkbox in the main window.

Initiate the Calibration process.
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Click the {Calibrate} button in the main window.  A dialog box appears prompting the user to select an
ICC Profile or Adobe Monitor Setup file to generate.
Click on the appropriate checkbox and continue. (see Figure 5-1)

Preset the display’s Brightness and Contrast.
Increase the display’s Contrast controls to Maximum.
Decrease the display’s Brightness controls to Minimum.
Click {Continue}.

Attach the calibration sensor to the display.
Match the black point luminance of the first and second displays.
Increase the Brightness controls of the display until the Current Luminance value matches the Target
Luminance value.

Note: Even with the Brightness controls minimized, the Current Luminance is greater than the Target
Luminance, the second display will not be able to achieve the black point luminance of the target
display.  In this case, you may wish to make the second display the target display.

Match the white point luminance of the first and second displays.
Decrease the Contrast controls of the display until the Current Luminance value matches the Target
Luminance value.

Note  Even with the Brightness controls maximized, the Current Luminance is less than the Target
Luminance, the second display will not be able to achieve the white point luminance of the target
display.  In this case, you may wish to make the second display the target display.

Continue the Calibration process.
Once the measurement process is complete, the correction will be applied to the display and the
application will return to the main window. The display of the second system is now calibrated to
match the target display of the first system.

Note: If there are more than two systems, repeat steps 13 through 22 with each additional system
display.

Modifying the Target Parameters.
After you have calibrated the displays once, the target parameters for the calibration can be changed
without the need for recalibrating. Toggle through the selections in the Targets and Curves droplist to
get an idea of the effect of each selection on the tone response of the display. Toggle through the
selections in the Color Temperature droplist to get an idea of the affect of each color temperature
selection.  When you have settled on a set of parameters, quit the application and the calibration will
remain active until the next time you run an OptiCAL calibration.

Note:  Unlike changes to the target tone response, changing the target color temperature will affect
the white point brightness.  The amount of brightness change will also vary from display to display.
Keeping the dynamic ranges of multiple displays accurately calibrated to each other when changing
the target color temperature will require resaving the target parameters and recalibrating the
secondary displays.

Maintaining Multi-System Calibration.
OptiCAL can be set to prompt you to recalibrate at set intervals.  Select the desired interval in the
Recalibration Period droplist of the Preferences dialog.
Follow the steps that you used to initially calibrate the secondary displays.  With the Calibration Mode
set to Precision, select the saved Target file and follow the same procedure as before.  Even the
target display can be recalibrated this way, using Precision Mode and the same Target file that was
used for the secondary displays.
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If you do not expect the need to reset the Brightness and Contrast of the displays because the
dynamic ranges of the displays still match, recalibrate with the Calibration Mode set to Standard.
When you reach the point of the process where you are asked to preset and fine tune the display’s
Brightness and Contrast controls, ignore the instructions and continue on with the calibration.
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Advanced Calibration features

OptiCAL allows the user to specifically establish criteria outside the prescribed Gamma curves and
color temperature values.  This enables the user to customize settings to meet the requirements
needed to accomplish specific color accuracy tasks.  These settings can be saved as a target profile.
For the tone response curve, the user can set numeric values by selecting Custom Gamma from the
pulldown menu.  The dialog box will prompt the user to input a value between 0.5 and 3.0.
For the color temperature, values between 40000K and 130000K (increments of 1K) can be keyed in
from the Custom selection.

Image 11: Targets and Curves; Color Temperature Menus
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The user can also manually adjust each or all tone response curves by setting the Expert Controls
located in the Preferences dialog box (see Figure 4-4).  The user can then move any of the control
points along the linear curve dynamically viewing the color changes.

Image 12: Curves Window with Control Points
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PreCAL

Overview

The PreCAL program is a monitor linearizing utility that is designed to work in conjunction with
OptiCAL.  It is an aid for prebalancing the color temperature of the display hardware utilizing the
display’s own front panel controls.

PreCAL
•  sets the intensity of the display’s phosphors so that the monitor is optimized for a desired color

temperature
•  maximizes the brightness range of the display
•  maximizes the color gamut of the display

PreCAL User InterFace
This section describes the PreCAL interface and how it is used.

Note: It is important to remember that OptiCAL should not be running when PreCAL is launched or
the Spyder will not be available for PreCAL to use.

Main Window
The main window is opened, and remains open, while the PreCAL utility is being used. Through this
window, the user is given step-by-step instructions on how to PreCAL-ibrate the color temperature of
the display.
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Preferences dialog
The Preferences dialog is opened from under the Edit menu.  Within the Preferences dialog, the
calibration sensor that is to be used can be defined.

Using PreCAL

Launch PreCAL by double clicking on the PreCAL icon which launches the PreCAL utility.

At the time PreCAL launches, it checks to see if it can detect the calibration sensor.  If the calibration
sensor cannot be found, a message dialog will appear indicating that the sensor must be selected
within the Preferences dialog.

To select a calibration sensor:
Make sure that your sensor is properly attached to the CPU. Open the Preferences dialog by
selecting Preferences from under the Edit menu. Choose the appropriate sensor type in the
Calibration Sensor droplist.  If necessary, also select the serial port to which the sensor is connected.
Once the calibration sensor is detected, close the Preferences dialog and PreCAL is ready.

The PreCAL Process

After the PreCAL utility is launched and the calibration sensor detected, follow on-screen instructions
to PreCAL-ibrate the color temperature of the display.

Step 1: Select a target color temperature.
At the top of the main dialog there is a Target Color Temperature droplist.  From this droplist, a
specific color temperature target can be selected from the list of standard color temperatures.  The
color temperature that is selected should be the same color temperature that will be used for the
OptiCAL calibration.

If the desired color temperature is not included in the droplist, select the Custom… option and type in
the target you desire in degrees Kelvin.

After a target color temperature has been selected, its Chromaticity Coordinates will be displayed in
the field below the Target Color Temperature droplist.
Click the Continue button to go on to the next step.
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Step 2: Open your display’s color controls.
The design and terminology for a display’s color controls is different for each display manufacturer.
Refer to the documentation of your display for a detailed description of its color controls.

In general, there are four types of display color controls.

No color control: Older monitors, and even some newer monitors, may not have any form of built in
color temperature control.  Unfortunately, if this is the case with your monitor, the PreCAL utility
cannot be used to PreCAL-ibrate the display’s color temperature.  However, do utilize the test
patterns supplied with PreCAL to optimize the display with the controls that are available.

Limited list of preset choices in degrees Kelvin: If your monitor gives you a list of predefined color
temperatures from which you can choose, select the temperature that most closely matches your
target color temperature.  With only this limited control available, going further with the PreCAL utility
is unnecessary.  Like the scenario above, do utilize the test patterns supplied with PreCAL to
optimize the display with the controls that are available.

Note: If your target color temperature is exactly between two of the preset choices, it is best to
choose the higher of the preset color temperatures.

Preset list of color temperature choices in degrees Kelvin plus the ability to define a specific
color temperature. By allowing the user to define a specific color temperature, a monitor with this
type of color control can be optimized using the PreCAL utility.  If your monitor has this type of color
control, set the display’s color temperature as close to the target temperature as possible.

Preset list of choices plus the ability to define the intensity of the individual red, green and blue
channels. Monitors with this type of fine color control are ideal and can be precisely tuned with
PreCAL to match the target color temperature. If your monitor has this type of color control, set the
intensities of the red, green and blue channels to their maximum setting.
Click the Continue button to go on to the next step.

Step 3: Attach the sensor to the screen. Firmly attach the calibration sensor to the screen, centering
it over the circle displayed in the main window.
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Click the Take Reading button to go on to the next step.

Step 4: Adjust the display’s color controls. PreCAL will cycle through a series of colors that it will
measure.  At the end of this process, three bars, each representing a color channel, will be displayed
in the right side of the main dialog.

By evaluating the three vertical color bars in relation to the horizontal tolerance bar, the necessary
color adjustment can be determined.  The goal for your adjustments is to get the tops of all three
color bars to be within the area of the tolerance bar.

If the color controls of your display allow editing the intensities of the individual color channels, the
proper correction for the bars in the illustration above would be to decrease the intensity of the blue
channel and increase the intensities of the red and green channels.

Note: If the intensity of a channel needs to be increased but the channel is already at its maximum
position, reduce the intensities of the other two channels to bring up the relative intensity of the one.

After each adjustment of the color controls, click the Take Reading button to update the color bars.
If the color controls of your display allow defining specific color temperature settings, increase or
decrease the current setting incrementally to get the vertical color bars as close to the tolerance bar
as possible. After each adjustment of the color controls, click the Take Reading button to update the
color bars.

Step 5: Finish the PreCAL-ibration process. When the color temperature of the display matches the
target color temperature, the tolerance bar will be bolded, indicating that the process is complete.  If,
however, you are unable to match the color temperature of the display to the target color
temperature, simply match as close as possible.  To help you with this, the exact chromaticity
coordinates of the display are shown in the CIE x,y fields below the color bars.
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Another good indicator of how close you are to the target is the CIE ∆uv value displayed below the
CIE x,y fields.  This value shows the difference between the target and current chromaticity
coordinates.  The lower the CIE ∆uv value, the closer the display’s color temperature is to the target
color temperature.
For displays that have color controls limited to defining specific color temperature settings, select the
setting that results in the lowest CIE ∆uv value.

After the color temperature of the display has been PreCALibrated to its optimum level, click the
Done button to close the main PreCAL window and quit the utility.

“PreCAL-ibration” of the display is complete.


